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e This enhances the photo to make it look more beautiful.

color, make skin look smoother, or change the color of a
jacket to make it brighter.
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m USING PHOTO EDITING TOOLS %

You can use Photo editing software to alter images, making them look more
professional.

Graphic designers, photographers, and other creative »
professionals often use expensive software such )
as Adobe Photoshop.

You can use similar tools for free with GNU Image
Manipulation Program (GIMP).

GIMP is an open-source software that can be used on G I M P
different operating systems.

The GIMP program is another creation tool that you can use for
presentations.

&

Some of the things you can do with GIMP
1 - Retouching al

1- Correct flaws in the photo.
Ex.: Change red eyes from camera glare to the original

2- Change the background.

This combines two images to make them look like one.
This is useful when you present an idea for something
that doesn’t exist yet or show what something might
look like.

If the photo was taken on a cloudy day, you can make
the sky seem brighter.

2 - Blending

3 - Special effects

e You can use different filters to add special effects to
an image.

e EX.: you can make it look like something is moving
in the photo with motion blur, or make it look very
old with the artistic filter gallery.
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» GIMP is an efficient and light program, so it doesn’t take up a lot of space on
your hard drive.

» It's a widely used program; there are online resources available to help you
learn how to use it.

» Although it has a large number of tools, you can customize the interface to
show only the tools that you need. You can also create keyboard shortcuts to
select tools easily.

» You can download the main GIMP software.

» There are many websites that allow you to use GIMP to edit photos online.

» GIMP supports different file formats, and you can convert the image to
different formats, such as: - PDF - GIF - JPEG.

QIO  Exoiorerinaction g

Ms. Sonika Manandhar is:
! |

1- financial technology entrepreneur 2-National Geographic Explorer
-She is from Nepal.
-Her studies focused on:
The engineering field, and robotics and artificial
intelligence at Singularity University at NASA, in
California.

Improving the Environment

e Ms. Manandhar uses her Xw, formerly known as
Twitter®, and Instagram accounts to spread awareness
of the benefits of green micro-entrepreneurs for
society.

e Ms. Manandhar wanted to use her knowledge to
improve the local environment in Republic of Nepal by
reducing the carbon emissions rate.

e She saw that using small electric buses could reduce
the emission rate.

e She noticed that most of the minibus drivers in the
capital Kathmandu were women
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The fintech company Aloi

e In 2019, Ms. Manandhar co-founded the fintech company Aloi.
e Aloi is a company that helps people use financial

services.
e Aloi helps women minibus drivers in the Republic of

Nepal to get low-interest loans. These loans are used to:

1- Buy electric minibuses =
2- Upgrade existing electric minibuses with long-lasting aloi

lithium-ion batteries.
e They receive and repay the loans through the company’s platform, which is
simpler and faster to use than most current bank loan procedures.

* When the funder approves a loan, the business owner
gets a digital token.

» She spends the token with an approved seller, such as
an electric vehicle seller.

* Then the business owner pays the funder back each
month from the profits of her business.

 All financial transactions are sent via SMS (text),
without the need to use the internet.

* The platform reports the payment information, so the funders know exactly
how the loans were spent and how much is paid back.

* Passengers can schedule rides on the company’s website and make payments
using digital tokens or mobile wallets.

Egypt's First Electric Car

e As part of its strategy to adopt a green economy,
o Egypt launched its first locally manufactured electric car.
e In February 2023, the Arab Academy for Science,
Technology and Maritime Transport announced the
vehicle’s specifications.
1. The vehicle is designed to accommodate five people.
2. Its maximum speed is 60 km/hr
3. It uses a lithium-ion battery.
e The electric car is expected to have an affordable price for the Egyptian market.
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/ Note:

¢ In Nepal, Riders can schedule and pay their rides using social media
messaging tools on Facebook and Instagram with the digital platform’s
tokens or their own mobile wallet.
e Mobile wallet is an app for storing money used to:
1- Send and receive funds 2- Pay bills
3- Book travel tickets 4- Subscribe to services
\ 5- Allow users to access their money and use it electronically anywhere and

__atany time.
OPERATING SYSTEMS AND SOFTWARE

It is the software that manages a computer’s functions, runs
and coordinates the communication between the software
and hardware, and allows a user to communicate with the
computer easily.

e Operating System (OS) is the most important software on your computer.
Without it, your computer is useless.

e OS ensures that all the software that is running at the same time gets what
it needs from the Central Processing Unit (CPU), memory, and storage.
This keeps your computer running smoothly. - -

» When you buy a computer or device, it usually has a pre-loaded OS. [ .
e Most laptops and computers have Microsoft Windows pre-loaded,
which is often used in schools and organizations. l’

e Apple Macintosh computers use macOS.
 You have to pay for different software for each of these Mac OS
e operating systems, and macOS is generally more expensive. -

.- s 5
e Smartphones and tablets use different operating . IOS l"
systems, such as Android and iOS.

Changing the System Settings

» You can change the settings of an OS by using a system settings control.
» These controls have different names and appearances depending on the OS:

- Windows: Control Panel - iOS: Control Center - macOS: System Preferences
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Windows Control Panel

» On most computers, you can locate the Control
Panel by typing “Control Panel” into the search box
in the taskbar.

All adjustable hardware and software settings and
configurations can be modified in the Control Panel.

Examplel Adding a New Wireless Printer

1- Select Hardware and Sound 2- Then Add a device i i
3- Select the one you want to add to your computer. J
Example 2 Removing a Device A—

1- Select Hardware and Sound 2-Then Add a device 3-Select Remove.

The changes you make in the Control Panel are automatically applied to other
software in your computer.

Example 3 Downloading a New Font
1- In the Control Panel, click on Fonts.
2- Drag and drop the font file from your Downloads folder into the fonts library.

* Then, when you open any Microsoft Office program, the new font will be
available in the fonts drop-down menu.

The layout and graphical interface of the Control Panel is different in each
version of Windows since programmers try to improve it each time an updated
OS is released.

Installing and Removing Programs

» Some software installs automatically.

» For example, when you plug a new printer into a PC, Windows downloads
the correct software so you can use it immediately.
It is also simple to remove computer programs from your computer using these steps.

Removing a program in Windows

- Open the Control Panel. Select Programs.

e Then select Programs and Features.

* Find the program you want to uninstall from the list.

e Right-click on it or press and hold, then select Uninstall or Uninstall/Change.
» Follow the directions on the screen.
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Removing a program in Android
* Open Google Play Store app, then tap on the Profile icon.

Tap Manage apps & devices, then Manage.

Press and hold the name of the app you want to uninstall, then tap Uninstall.
\\‘
/Note:

» Linux is a family of open-source operating systems, which includes variants
such as Fedora, Linux Mint, and Debian.

» Open-source means that anyone can run Linux for any purpose and make
changes to it. It can be distributed by anyone around the world.

» Operating systems that use Linux often run faster and more efficiently than
other OS, such as Windows.

m WRITING AND SHARING REPORTS O.

Writing a report in Microsoft Word

e Microsoft \Word is still the most reliable creation tool
to use for writing reports to share information.

e You've become quite comfortable writing reports in Microsoft Word and
using Microsoft Word tools.

¢ To choose between different designs in Microsoft Word:
Click on the Layout and Insert tabs and choose the elements you want to
include.

Choose the font you would like to Use the "Layout” tab:
use from the drop-down menu. Choose from available
Begin typing. options

Use the ‘Insert’ tab:

= Click Insert on the menu bar.

= Click Picture.

= Choose the picture you want to include.

« Click on it to insert the picture in your document,
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Microsoft Word tools

Formatting tools
To: -Add bold, and italicize words - Set up headings
- Create tables - Insert images, hyperlinks, and footnotes.

Editing tools
To -Check reports for spelling, grammar, and conciseness.

Preview tools
To -View a document before saving or printing.

Messaging Services

¢ You can use messaging services, such as the \WhatsApp to:

- Communicate ideas. - Share information.

¢ You might also use messaging services to collaborate on a group project or
to seek feedback from classmates or teachers.

e Like text messaging, messaging services allow you to send:
- Text - Images - Voice messages - Videos

¢ You can include one person in a chat, or many people.

Advantages of messaging services like \WhatsApp over standard text
messaging

1. Since they use the internet, messages are almost

always free to send and receive.
2. There are no special prices to worry about when

messaging someone from across the world.

3. Messages sent are encrypted — only the intended

recipient will be able to see the message.

4. Messaging services are compatible on any device
and with both Android and Apple products.
There are no restrictions.
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CREATING A PRESENTATION

e You can use Office Suite to create presentations to express
opinions and ideas.

e A suitable design can make presentations engaging and visually
appealing.

Microsoft PowerPoint

e Itincludes drawing and writing tools to create text.

__animation options to add movement to sentences and words on your slides.

e You can use Microsoft PowerPoint to create presentations to communicate
ideas and opinions.

¢ PowerPoint has easy-to-use tools to help make material visually appealing to
interest viewers.

Tools for creating a presentation in PowerPoint

Tool Usage
Design tab >> Slide Size - Click on it to choose the size of your slide
- Choose Standard or Widescreen.
- Customize your own slide size.

Design tab >> -These tools help you to choose a style for your
Themes and Variants presentation, including design and text placement.

Save As >> PDF option - To save your presentation as a PDF file before printing to

keep its formatting.

Edit in Review mode - To review your presentation.
- In Review mode, you can make your changes, if there any
text errors or issues with the layout.

File tab >> Print - To see a final preview of your flyer and click Print.

Insert tab >> Pictures -To add pictures to your presentation to help get your
message across.
-You can upload pictures from an online picture bank, a
screenshot, or from your photo album.

Insert tab >> Text box  -to write your Text
- Use the Text Box to carefully craft your message.
-You can also use SmartArt but make sure it’s easy to read.
-Remember the 10-20-30 rule when it comes to text size!

10-20-30 Rule

e Slides shouldn’t be more than 10 slides
e Duration shouldn’t be longer than 20 minutes

e Fonts shouldn’t be smaller than 30 point size
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software that can be used on different operating
systems to change images.

@ Close source open source @ paid source
The purpose of photo editing software is to .........................

write documents @ surf the internet @ alter images
GIMP Is A s Program.

@ free @ paid @ expensive

............. is an open source image manipulation program that used on
different operating systems.

(@ HTML (® GImpP (©) Adobe Photoshop
........................... is an example of paid photo editing software.

MS word ® GIvP (©) Adobe Photoshop
By using blending feature in GIMP, you can................ two images.
separate @ combine @ delete

You can correct.........siusees in a photo using GIMP.

flaws @ audio quality @ video frames
"Retouching” feature in GIMP software involves .................... .

writing codes @ editing videos @ enhancing photos
Yourcam add vy to an image using GIMP.

@ audio @ special effects @ video

You can use different ............... to add special effects to an image in GIMP.

filters @ flaws @ codes

You can make image look like something is moving in the photo with .......

artistic filter

gallery @ generic filter

@ motion blur
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You can make an image look very old with ...........cccceeeneneees 1

artistic filter
gallery

Ms. Sonika Manandhar is from.......................... :

@ USA @ Nepal @ Kenya

@ motion blur @ generic filter

Ms. Manandhar studies focused on the ............... at Singularity University.
@ engineering field @ Al and robotics @ all the previous
Ms. Manandhar Uses ........c...ceusunee accounts to spread awareness of the
benefits of green micro-entrepreneurs for society.
@ Xmw (Twitter®) @ Instagram @ both of them
Ms. Sonika Manandhar is a/ an ..........cccccccueeeens entrepreneur.

financial - .
(a) teahnology (®) social (©) electronic games

Ms. Manandhar want to use her knowledge to ............ccccuu... !
study at google @ improve the local @ increase the

environment emission rate
Egypt is launching its first electric car to adopt .........cccevnnrisnnns i
self-driving cars @ Green economy envrrqnmental
pollution
AlOI IS @ oiliuunsstns company helps people use financial services.

fintech @ healthcare @ education
In Nepal, Passengers can pay for their rides through .................. .
@ digital tokens @ mobile wallets @ bothaandb

Aloi assists women from Nepal who drive minibuses to get ...........ccce...... ‘

medium-interest

loans @ high-interest loans

low-interest loans

The business owner receive a ........cccvvueeeennns upon loan approval.

@ bank transfer @ cash @ digital token

Ms. Manandhar wanted to reduce the carbon emissions rate by ..................

using petrol cars @ using electric cars @ using gas cars

The first Egyptian electric car uses a....................... battery.
lithium-ion () lead-acid (©) nickel- cadmium
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@ .................... is an app for storing money, you can use it to pay bills.

@ Physical token @ Mobile wallet @ Social media app
@ Egypt’s first electric car is designed to accommodate .................... people.

@ 3 ® s © 7
@ Egypt’s first electric car maximum speed is ..........c...... km/hr.

@ 60 (® 90 © 120
All financial transactions are sent via ................. , without the need to use

the internet.

Email @ Bank acount @ SMS

@ Operating system coordinates the communication between ...................... '
@ hardware only @ software only ?:f;m?ge el
@ Operating system is a type of .......cccccceereu. ’
Software @ hardware EI r:gl:zr;:ing
@ Smartphones and tablets use ................ operating system.
(@ android (® ios (©) bothaandb
@ Apple Macintosh computers use ..........cccecueeees operating system.
iOS (&) macos (®) Linux
@ The system settings control called ......................... in Windows.
@ Control Center @ Control Panel @ System Preferences
@ The system settings control called ......................... in macOS.
Control Center @ Control Panel @ System Preferences
@ The layout and graphical interface of the Control Panel s ................ in

each version of Windows.

different @ the same @ typical

To add a new wireless printer in Windows, You can select ............ccccoeeecunnee. i
then add a device.
@ System and Hardware and Network and
Security Sound Internet

@ To download a new font in Windows, open control panel. Click on ............

(@ Fonts (b) Format (©) Networks
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The system settings control called ......................... in iOS.

@ Control Center @ Control Panel @ System Preferences
You can easily remove a program in windows by selecting .................. in

control panel, then uninstall.

; Programs and

@ System and Security @ Features © Network and Internet

@ .............................. is still the most reliable creation tool to use for writing

reports to share information.
@ Microsoft Word @ Microsoft Excel @ Microsoft Access

@ ................... tools in Microsoft Word allows you to insert images,
hyperlinks, and footnotes.
@ Review @ Editing @ Formatting

Messaging services, such as .............. used worldwide for communication.

@
@ aGvp (6) WhatsApp ®© Aloi
@

................... tools in Microsoft Word used to check reports for spelling,
grammar, and conciseness.

@ Preview @ Editing @ Formatting

@ You can view a document before saving or printing by using ...................
tools in Microsoft Word.
@ Preview @ Editing @ Formatting
@ Messaging services are compatible with ....................... operating system.
(@ Android Tol3 (©) bothaandb
You can choose different designs in Microsoft \Xord by clicking on
.................. tab.
@ Insert @ Layout @ bothaandb
Messages sent in WhatsApp are ....................... £
encrypted @ hacked @ unencrypted

You can use messaging services, such as the WhatsApPpP to ....ccccccvueeeenn

communicate Share
ideas information @ both a and b

By using WhatsApp messaging services, you can include. ............. in a chat.

@ one person @ many people @ bothaandb
@ ................. is a software program that can be used to create presentations.

(@ m™s word (6) MsPowerPoint (€) MS Excel
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The recommended rule to follow in a PowerPoint presentation is ................

@ 51015 (®) 102030 (©) 203040
YOU CAN-USE .uuousastimsssusiniss in PowerPoint to create text and carefully craft
your message.

@ Pictures @ Themes @ Text box

The maximum recommended duration for a PowerPoint presentation is .............
minutes.

@ 10 ® 20 © 30

Fonts shouldn’t be smaller than ....... point size in PowerPoint presentation
30 ® 40 © so
Slides shouldn’t be more than ............. slides in a PowerPoint presentation.

@ s ® 7 ®© 10

.................... tab in PowerPoint allows you to choose a style for your
presentation.

@ Design @ Insert @ Save As

To see a final preview of your presentation before printing, click on............
tab.

@ Design @ File @ Insert

................. tool can be used to add movement to sentences and words in
PowerPoint.

\Writing @ Design @ Animation

) ouestiono2  \FITTRITIIEY

@OPO®OE® ©

Graphic designers use expensive photo editing software, such

as Adobe Photoshop. ( )
GIMP is closed source software that can't be used on different ( )
operating systems.

The GNU Image Manipulation Program is paid software.
GIMP can be customized to display only the tools a user needs.

With GIMP, you cannot correct flaws in a photo.

Adobe Photoshop and GIMP are free photo editing software.

( )
( )
( )
Many websites allow you to use GIMP to edit photos online. ( )
( )
( )

GIMP can be used to blend two images together.
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GIMP does not support adding special effects to an image. ( )
GIMP is a heavy program that requires a lot of disk space. ( )
You can find online resources to learn how to use GIMP. ( )
In GIMP, you can convert the image to different formats, such as ( )

PDF, GIF and JPEG.

You can't change the background of images in GIMP. ( )
GIMP allows you to change the color of objects in a photo. ( )
GIMP can only be used on windows devices. ( )
Ms. Sonika Manandhar co-founded the fintech company Aloi. ( )
Ms. Manandhar uses her Xw, formerly known as Twitter®, and ( )
Instagram accounts to spread awareness.

Ms. Manandhar noticed that most of the minibus drivers in the ( )
capital Kathmandu were men.

Aloi assists women minibus drivers in Nepal to obtain high-interest ( )
loans.

Passengers can schedule rides online through the company's ( )
website.

The electric minibuses could increase the emission rate. ( )
Mobile wallet can be used to pay bills. ( )
Using electric cars as a part of Egypt's strategy to adopt a green ( )
economy.

The electric car is expected to have an appropriate price for ( )
the Egyptian market.

All financial transactions are sent via Email, with the need to use ( )

the internet.
The loans obtained through Aloi are used to purchase petrol cars.

Aloi handles the loans process through the company’s platform.
Egypt's first electric car is designed to accommodate seven people.
Ms. Manandhar studied engineering field, robotics and Al.

Most laptops and computers have Microsoft Windows pre-loaded.
All smartphones and tablets use the Android operating system.

MacOS is generally more expensive than other operating systems.

®
0
@
®
)
)
)
@9
@
@
@
2
@)
@
%9
@
@
&)

In Windows, the system settings control is called Control Center.
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The changes you make in the Control Panel are automatically ( )
applied to other software.

Without an operating system, your computer will become useful. )

You can change the settings of an OS by using a system settings ( )
control.

The layout and graphical interface of the Control Panel stay ( )
constant in all versions of Windows.

To uninstall an app on Android devices, you need to open Google ( )
Play Store app.

OS coordinates and manages the communication between your ( )
hardware and software.

All fonts are pre-downloaded on your computer, and you can't ( )
download a new font.

To remove a device, select Hardware and Sound from Control ( )
Panel, then select install.

Linux is a family of open-source operating systems. ( )

Linux often run faster and more efficiently than other OS, such ( )
as Windows.

Microsoft Word is primarily used for writing reports.
Microsoft Word allows you to italicize words using editing tools.

You can only include one person in a chat through WhatsApp.

You can choose different designs in MS Word by clicking on the
Layout and Insert tabs.

MS Word allows you to set up headings using formatting tools. ( )

There are special prices when messaging someone from across the | )
world on WhatsApp.

Messaging services are compatible only with Android devices. ( )

You can view a document before saving or printing by using ( )
Preview tools in Microsoft Word.

Sending a photo using WhatsApp doesn't require internet access.  ( )

You can create tables by using Formatting tools in Microsoft Word. ( )

You can choose the font you would like to use from the drop-down ( )
menu in Home tab.

You can use SmartArt in PowerPoint. ( )
You cannot preview your presentation before printing. ( )
Office Suite can be used to create presentations to express ideas. ( )

( )

MS PowerPoint includes drawing and writing tools to create text.

9
@
4o
@
@
@
@
D)
@
5o
@
&
&
&9
&)
)
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All lessons in Theme 4 are scheduled, and there are no enrichment lessons.

@OOPO®O®®
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You can add pictures from the internet in PowerPoint.

As Per 10-20-30 rule, PowerPoint should exceed 10 slides.
You can customize your own slide size in PowerPoint.
PowerPoint allows saving presentations as PDF file.
PowerPoint does not provide text animation options.

You can choose the size of your slide as Standard only.
Review mode allows you to check any text errors or issues with the

G839l 2L CluoV! Lubi go dliwl gl

Theme 3 Lesson 7

Theme 4 Lesson 1

Theme 4 Lesson 2

Theme 4 Lesson 3

Theme 4 Lesson 4
n h

Choose the correct answer

From Q1 to Q12
From Q13 to Q28
From Q29 to Q39
From Q40 to Q51
From Q52 to Q60

Put (T) or (F)
From Q1 to Q15
From Q16 to Q29
From Q30 to Q43
From Q44 to Q54
From Q55 to Q65

SN (g o (g1 s Y 985500 Al Headl gy aaen

."3umiw agoae /1 - ju

By: Mrs Suzy Atef
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Question 01 choose the correct Answer

GIMPIS an ...l software that can be used on different operating
systems to change images.
@ Close source open source @ paid source

The purpose of photo editing software is to ..............cc.........

write documents @ surf the internet @ alter images
GIMP Is A s Program.

free @ paid @ expensive

............. is an open source image manipulation program that used on
different operating systems.

® ® 6

(@ HTML ® aGimp (©) Adobe Photoshop
........................... is an example of paid photo editing software.

MS word ® GIvP (© Adobe Photoshop
By using blending feature in GIMP, you can................ two images.
separate @ combine @ delete

You can correct.........siusees in a photo using GIMP.

flaws @ audio quality @ video frames
“Retouching” feature in GIMP software involves ....................

. writing codes @ editing videos @ enhancing photos

Yourcam add vy to an image using GIMP.
audio @ special effects @ video
You can use different ............... to add special effects to an image in GIMP.

filters @ flaws @ codes

You can make image look like something is moving in the photo with .......

@6@0@@@

artistic filter

gallery @ generic filter

@ motion blur
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You can make an image look very old with ...............ccccueu..... 1
artistic filter

@ motion blur @ generic filter

gallery
Ms. Sonika Manandhar is from ......................... :
@ usa (®) Nepal (©) Kenya
Ms. Manandhar studies focused on the ............... at Singularity University.
@ engineering field @ Al and robotics @ all the previous
Ms. Manandhar USes ..........cccveuenne accounts to spread awareness of the
benefits of green micro-entrepreneurs for society.
@ Xmw (Twitter®) @ Instagram @ both of them
Ms. Sonika Manandharisa/ an...........cccccceeeaes entrepreneur.
(a) financial (®) social (©) electronic games

technology
Ms. Manandhar want to use her knowledge to ..........c.cccceu.... :

improve the local increase the
tudy at | . S
StUEY at guegie @ environment @ emission rate

Egypt is launching its first electric car to adopt ........ccccevrseeerians ’

environmental

self-driving cars @ Green economy pollution

AlOI IS @ oiliuunsstns company helps people use financial services.

fintech @ healthcare @ education

In Nepal, Passengers can pay for their rides through .................. ;
@ digital tokens @ mobile wallets @ both a and b

Aloi assists women from Nepal who drive minibuses to get ...........cccc...... ‘

medium-interest

low-interest loans @ high-interest loans

loans
The business owner reCeive a .........cccecvvesennes upon loan approval.
@ bank transfer @ cash @ digital token

Ms. Manandhar wanted to reduce the carbon emissions rate by ..................

using petrol cars @ using electric cars @ using gas cars

The first Egyptian electric car uses a .......cccccceveeeees battery.
lithium-ion () lead-acid (©) nickel- cadmium
000 St ALt et o ol i
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@ .................... is an app for storing money, you can use it to pay bills.

@ Physical token @ Mobile wallet @ Social media app
@ Egypt’s first electric car is designed to accommodate .................... people.

@ 3 ® s © 7
@ Egypt’s first electric car maximum speed is ..........ceeuue. km/hr.

@ 60 (® 90 © 120
All financial transactions are sent via ................. , without the need to use

the internet.

Email @ Bank acount @ SMS

@ Operating system coordinates the communication between ..........c.ccuuc... .
hardware only @ software only ?:frtg\;‘:;?f and
@ Operating system is a type of ..................... :
Software @ hardware EI r:gl:zr;:iing
@ Smartphones and tablets use ................ operating system.
android (® ios (© bothaandb
@ Apple Macintosh computers use ..........cccecueeees operating system.
Tl (® macos (®) Linux
@ The system settings control called ......................... in Windows.
@ Control Center @ Control Panel @ System Preferences
@ The system settings control called ......................... in macOS.
Control Center @ Control Panel @ System Preferences
@ The layout and graphical interface of the Control Panel s ................ in

each version of Windows.

different () the same ® typical

To add a new wireless printer in Windows, You can select ............ccccoeceeuneee. i
then add a device.
@ System and Hardware and Network and
Security Sound Internet

®

To download a new font in Windows, open control panel. Click on ............

@ Fonts @ Format @ Networks

T ﬁo o oy 2o JUS 3o Caluislg CilySaall le Jgumall asisas
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The system settings control called ...............ccuc..... in iOS.

@ Control Center @ Control Panel @ System Preferences
You can easily remove a program in windows by selecting .................. in

control panel, then uninstall.

Programs and

@ System and Security @ Features © Network and Internet

@ .............................. is still the most reliable creation tool to use for writing

reports to share information.
@ Microsoft Word @ Microsoft Excel @ Microsoft Access

@ ................... tools in Microsoft Word allows you to insert images,
hyperlinks, and footnotes.

@ Review @ Editing @ Formatting
@ Messaging services, such as .............. used worldwide for communication.

@ aGvp (®) WhatsApp ®) Aloi

................... tools in Microsoft Word used to check reports for spelling,
grammar, and conciseness.

@ Preview @ Editing @ Formatting

@ You can view a document before saving or printing by using ...................
tools in Microsoft Word.
@ Preview @ Editing @ Formatting
@ Messaging services are compatible with ....................... operating system.
(@ Android (o) ios (©) bothaandb
You can choose different designs in Microsoft \Xord by clicking on
.................. tab.
@ Insert @ Layout @ bothaandb
Messages sent in WhatsApp are ....................... £
encrypted @ hacked @ unencrypted

You can use messaging services, such as the WhatsApPpP to ....ccccccvueeeenn

communicate Share

ideas information @ bothaand b

By using WhatsApp messaging services, you can include. ............. in a chat.

@ one person @ many people @ bothaandb
@ ................. is a software program that can be used to create presentations.

(@ m™s word (®) MsPowerPoint (€) MS Excel
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The recommended rule to follow in a PowerPoint presentation is ................

@ 51015 (® 102030 (©) 203040

YOU CAN-USE .uuousastimsssusiniss in PowerPoint to create text and carefully craft
your message.

@ Pictures @ Themes @ Text box

The maximum recommended duration for a PowerPoint presentation is .............
minutes.

@ 10 ® 20 © 30

Fonts shouldn’t be smaller than ....... point size in PowerPoint presentation
30 ® 40 © so
Slides shouldn’t be more than ............. slides in a PowerPoint presentation.

@ s ® 7 © 10

.................... tab in PowerPoint allows you to choose a style for your
presentation.

@ Design @ Insert @ Save As
To see a final preview of your presentation before printing, click on............
tab.

@ Design @ File @ Insert

................. tool can be used to add movement to sentences and words in
PowerPoint.

\Writing @ Design @ Animation

I put (V) or(x)

®
@
®
@
®
®
®
®

Adobe Photoshop and GIMP are free photo editing software.

Graphic designers use expensive photo editing software, such
as Adobe Photoshop.

GIMP is closed source software that can't be used on different
operating systems.

The GNU Image Manipulation Program is paid software.
GIMP can be customized to display only the tools a user needs.
With GIMP, you cannot correct flaws in a photo.

Many websites allow you to use GIMP to edit photos online.

AxXAxA % x <

GIMP can be used to blend two images together.
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GIMP does not support adding special effects to an image.

GIMP is a heavy program that requires a lot of disk space.

In GIMP, you can convert the image to different formats, such as
PDF, GIF and JPEG.

You can't change the background of images in GIMP.

x
x
You can find online resources to learn how to use GIMP. \/
v

GIMP allows you to change the color of objects in a photo.
GIMP can only be used on windows devices.

Ms. Sonika Manandhar co-founded the fintech company Aloi.

Ms. Manandhar uses her Xw, formerly known as Twitter®, and
Instagram accounts to spread awareness.

Ms. Manandhar noticed that most of the minibus drivers in the
capital Kathmandu were men.

Aloi assists women minibus drivers in Nepal to obtain high-interest
loans.

Passengers can schedule rides online through the company's
website.

The electric minibuses could increase the emission rate.

Mobile wallet can be used to pay bills.

Using electric cars as a part of Egypt's strategy to adopt a green
economy.

The electric car is expected to have an appropriate price for

the Egyptian market.

All financial transactions are sent via Email, with the need to use
the internet.

The loans obtained through Aloi are used to purchase petrol cars.
Aloi handles the loans process through the company’s platform.
Egypt's first electric car is designed to accommodate seven people.
Ms. Manandhar studied engineering field, robotics and Al.

Most laptops and computers have Microsoft Windows pre-loaded.
All smartphones and tablets use the Android operating system.

MacOS is generally more expensive than other operating systems.

®
)
@
®
)
)
@
@9
@
@
@
2
@)
@
49
@
@

XLXLLXCE X Q CLUx L x x KLxLx

In Windows, the system settings control is called Control Center.
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The changes you make in the Control Panel are automatically
applied to other software.

Without an operating system, your computer will become useful.

v
x

You can change the settings of an OS by using a system settings v

control.

The layout and graphical interface of the Control Panel stay '3

constant in all versions of Windows. h

To uninstall an app on Android devices, you need to open Google v

Play Store app.

OS coordinates and manages the communication between your v

hardware and software.

All fonts are pre-downloaded on your computer, and you can't )4

download a new font.

To remove a device, select Hardware and Sound from Control

Panel, then select install.

Linux is a family of open-source operating systems.

Linux often run faster and more efficiently than other OS, such
as Windows.

Microsoft Word is primarily used for writing reports.
Microsoft Word allows you to italicize words using editing tools.

You can only include one person in a chat through WhatsApp.

You can choose different designs in MS Word by clicking on the
Layout and Insert tabs.

MS Word allows you to set up headings using formatting tools.

There are special prices when messaging someone from across the
world on WhatsApp.

Messaging services are compatible only with Android devices.

You can view a document before saving or printing by using
Preview tools in Microsoft Word.

Sending a photo using WhatsApp doesn’t require internet access.

You can create tables by using Formatting tools in Microsoft Word.

You can choose the font you would like to use from the drop-down
menu in Home tab.

You can use SmartArt in PowerPoint.
You cannot preview your presentation before printing.

Office Suite can be used to create presentations to express ideas.

CAX L CCx K% X A%xx A« x%

MS PowerPoint includes drawing and writing tools to create text.

9
@
4o
@
@
@
@
D)
@
5o
&
&
&9
&)
)
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All lessons in Theme 4 are scheduled, and there are no enrichment lessons.
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You can add pictures from the internet in PowerPoint.

As Per 10-20-30 rule, PowerPoint should exceed 10 slides.
You can customize your own slide size in PowerPoint.
PowerPoint allows saving presentations as PDF file.
PowerPoint does not provide text animation options.

You can choose the size of your slide as Standard only.
Review mode allows you to check any text errors or issues with the

G839l 2L CluoV! Lubi go dliwl gl

Theme 3 Lesson 7

Theme 4 Lesson 1

Theme 4 Lesson 2

Theme 4 Lesson 3

Theme 4 Lesson 4
n h

Choose the correct answer

From Q1 to Q12
From Q13 to Q28
From Q29 to Q39
From Q40 to Q51
From Q52 to Q60

Put (T) or (F)
From Q1 to Q15
From Q16 to Q29
From Q30 to Q43
From Q44 to Q54
From Q55 to Q65

SN (g o (g1 s Y 985500 Al Headl gy aaen
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By: Mrs Suzy Atef
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